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RedCrab The Calculator 
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RedCrab is a freeware program.  
 
Software and manual are copyright. You can copy and pass it, but it is forbidden 
to change the software or the manual.  
 
We are not liable for any error in software or manual. Usage at your own risk. 
 
 
System requirement 
Minimum Pentium P4 and 512 MB RAM.  
Operating system: Microsoft Windows.  
The following fonts: Courier New and Symbol must be installed in your system. 
These fonts belonged to Microsoft *Windows systems.  
 
The program works on Linux OS with Wine runtime system. 
 
No installation of the software is required. You can just copy the software to 
your system and starts the programs. 
   

Calculation range: 1.7e 308 to 5e-324 
Accuracy:   15 digits 
Display:   15 digits 
 
*
Windows is a registered trademark of Microsoft Corporation. All other 

trademarks are the property of their respective owners. 
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RedCrab – The Calculator 
 
RedCrab is a scientific calculator with a full screen editor. Mathematical 
expressions are not entered here in a single command line, but writing in any 
editor position similar to a sheet of paper. 
  
The handling of the basic functions is just like a conventional calculator. There 
is no training required. Whoever can operate a pocket calculator can also use 
RedCrab without studying the manual. This guide describes advanced features 
which a normal calculator does not possess. 
 
Additional Information: www.redchillicrab.com/en/redcrab/tutor.html 
 
RedCrab is fully portable. The program can be started from external data 
storage source without installation. Settings can be stored as a file in the 
programs root directory instead in the PC' s Windows registry. If you start 
RedCrab from a USB flash drive, your settings are stored on the stick. See also 
the paragraph at the bottom: 6.57 Settings to Registry. 
 



1.0 Mathematical Expressions
 
 
 

1.1 Basics 
 
You can write your formula basically at any editor position. Any expression 
may occupied any number of rows and columns. 
expression and continue in the next row.
 
Wrong:    z = 12+14+15+20

+5+10

 
Correct: z = 12+14+15+20+5+10

 
Correct: X = 12+14+15+20

  Z = X+5+10

 
 
 
You can write several 
expressions result displays only if terminated with equal sign.
 

Example 1:  a+b   =

     a=27+9 

   8*4   =

    b=12*6  =

 
 
 
Several mathematical expression
mathematical expression, there
(defined in Menu Options.Column Space
 

Example 1: 
 
 
 
 

Example 2: 
 

1.0 Mathematical Expressions 

You can write your formula basically at any editor position. Any expression 
may occupied any number of rows and columns. It not allowed to split a
expression and continue in the next row. 

z = 12+14+15+20 

+5+10 

z = 12+14+15+20+5+10 

X = 12+14+15+20 

Z = X+5+10 

u can write several mathematical expressions on one work sheet. The 
expressions result displays only if terminated with equal sign.  

=108 

=32  

=72 

mathematical expressions can be written per row.  
, there must either a minimum number at

Menu Options.Column Space) or  a colon must be set.

You can write your formula basically at any editor position. Any expression 
It not allowed to split an 

mathematical expressions on one work sheet. The 

row.  Between each 
a minimum number at blank columns 

colon must be set. 



 

The minimum distance displayed at bottom right corner, 
next to the keyboard setting. In example 2 the minimum 
distance is set to 4 columns.
 

 
 

An equal sign behind a formula
is always assigned to the
previous formula, even 
distance to the formula
greater than the column space 
setting. In the example right
distance of the equal sign
to eight columns, although
minimum distance is only
columns. 
 
 
 
 
Close proximity can caused
marked the cell where an error is detected with a blue frame. It also marks the 
incorrect formula with a red frame. 
is signaled. The red box shows
the distance is too close. 
between the formulas is only
 
 

 

 
 
 

1.2 Simple Addition
 
1. Enter the expression 17 + 4
2. For result press Ctrl+Enter
 

The minimum distance displayed at bottom right corner, 
t to the keyboard setting. In example 2 the minimum 

distance is set to 4 columns. 

formula 
to the 

, even if the 
formula is 

column space 
right, the 

of the equal sign is up 
although the 
is only four 

caused unexpected errors. For error localization
marked the cell where an error is detected with a blue frame. It also marks the 
incorrect formula with a red frame. In the example below, an invalid

shows, however, that two formulas were
. The setting in this example is 4 columns
only 2 columns. 

 

Simple Addition 

Enter the expression 17 + 4 
Enter 

For error localization RedCrab 
marked the cell where an error is detected with a blue frame. It also marks the 

an invalid assignment 
were joined because 

columns, the distance 



The Ctrl+Enter key starts RedCrab and displays the result. Alternative click the 
function panels Enter button. Results are always displayed in blue. 
 

The display shows: 17+4=21 

 
 
 

Variable and  Values 
 

1. Enter the expression 17 + 4 + X 
2. Enter the assignment X = 43 
3. For result press Ctrl+Enter 
 
RedCrab displays the result:  64 
 

The display shows:   17+4+X=64 
X=43 

     

 
The assignment can be entered at any position.  
 
 
 

1.3 Exponent 
 

The expression: c = a2 + 42
.  

 

1. Enter the expression: c   =  a   Ctr+2  +  4  Ctr+2 + = 
2. Press Ctrl+Enter to display result. 
 

The display shows: c=3
2
+4

2
=25 

 

The keys Ctrl+2 write the exponent 2. With the keys Ctrl+3 you can write the 
exponent 3. For use of any other values for exponents, press the Ctrl+6 keys or 
click the Superscript Button to enter the Super mode. Then enter the exponent 
value. Press Ctrl+6  or Enter  or click the Superscript Button to leave the super 
mode. 
 
 
 



1.4 Subscript and
 

Enter the formula: XL = ω
 
1. Press the following keys :  X   

2. Enter the assignment ω
3. Enter the assignment f = 2200
4. Enter the assignment L=0.8 10
5. Press the keys Ctrl+Enter
 
With the keys Ctrl+_ 
Alternative use Enter to leave 
 
The Ctrl key shifts the letters to the alternative font. The example above shows 

that the keys Ctrl+P displayed the Hellenic letter 
   

The display shows: 
 

 
 
 
 
 
 

The example above show 
multiplication. That means 
operator  
 

Example:  RedCrab interprets
 

RedCrab interprets a sequence of letters, for example, 
Exclude subscript letters, for example 
variable on the left. 
 
Example: 
  abc : a * b * c
   
  3ab : 3 * a * b
  
  2XL = 2 * XL

 
  R1R2 = R1 * R
 
 

and Implied Multiplication

ωL 

Press the following keys :  X   Ctr+_   L  Enter  =  Ctrl+W  L

ω=2πf ;  press the keys : Ctrl+W = 2  Ctrl
Enter the assignment f = 2200 
Enter the assignment L=0.8 10-3; press the keys : L = 0.8 10 Ctrl

Enter 

 (underscore) you can switch Subscript
to leave Subscript region. 

the letters to the alternative font. The example above shows 

displayed the Hellenic letter Pi (π).π).π).π). 

The example above show one more features of RedCrab: 
means you do not need to include the multiplication 

Example:  RedCrab interprets XL = ωL as XL = ω ∗ L 

interprets a sequence of letters, for example, ab, as different variable. 
Exclude subscript letters, for example XL.  Subscript letters always belong

abc : a * b * c 

3ab : 3 * a * b 

L 

* R2 

Implied Multiplication 

L = 

Ctrl+P  f 

Ctrl+6 - 3 Enter 

Subscript on / off. 

the letters to the alternative font. The example above shows 

one more features of RedCrab: the implied 
you do not need to include the multiplication 

, as different variable. 
.  Subscript letters always belong to the 



Use the Escape mode if you want 
Read more about the Escape mode in the description below. 
 
 
 

1.5 Fraction and 
 

Enter a formula with a fraction and a square root.
 
1. Enter the fraction line an
2. Enter the denominator : 2 
3. Assignment  L : L=0.8 10 
4. Assignment  C: C=4.7 10 
5. Press Ctrl+Enter for result.
 
The display shows: 
 
 
 
 
 
 
 
 
 

To write a fraction line press 
information below about fractions in the description.
 
The keys Ctrl+1 write a root symbol at the cursor position, 
range which should be below the root. Click the root symbol and the editor draw 
the root line above the marked range. Read more information about square roots 
in the description below. 
 
 
 

1.6 Hexadecimal
 
The RedCrab editor accepts input of hexadecimal numbers up to 13 digits. The
hexadecimal number must mark with 
or capital letters are allowed.
 
Example: $1F2A or 1f2a
 
 

Use the Escape mode if you want a sequence of letters for a single variable. 
Read more about the Escape mode in the description below.  

Fraction and Square Root 
Enter a formula with a fraction and a square root. 

and the numerator : f = Ctrl +/  Enter 1 
Enter the denominator : 2 Ctrl+P  Ctrl + 1 LC 
Assignment  L : L=0.8 10 Ctrl+6 - 3 
Assignment  C: C=4.7 10 Ctrl+6 - 6 

for result. 

To write a fraction line press  Ctrl+/  (forward slash) key. Read more 
information below about fractions in the description. 

write a root symbol at the cursor position, and then
range which should be below the root. Click the root symbol and the editor draw 

root line above the marked range. Read more information about square roots 
 

Hexadecimal, octal and binary 

The RedCrab editor accepts input of hexadecimal numbers up to 13 digits. The
exadecimal number must mark with a dollar symbol before it. The use of

or capital letters are allowed. 

$1F2A or 1f2a 

a sequence of letters for a single variable. 

1 Enter 

(forward slash) key. Read more 

and then mark the 
range which should be below the root. Click the root symbol and the editor draw 

root line above the marked range. Read more information about square roots 

 Input 

The RedCrab editor accepts input of hexadecimal numbers up to 13 digits. The 
a dollar symbol before it. The use of small 



An octal number is marked with the dollar symbol and the letters oct. The length 
is limited to 20 characters. 
 

Example: $oct3721 

 
 
A binary number is marked with the dollar symbol and the letters bin. The 
length is limited to 20 characters. 
 

Example: $bin110101 

 
 
You can use hexadecimal, octal or binary numbers in any position of a formula 
like decimal numbers. Between this number and the following number or 
variable must be a space or operator symbol. 
 
Example: Correct: $1F2A*X or $1F2A X 

Wrong: $1F2AX => generate an error message. 
 
Results can be displayed as hexadecimal, octal or binary number in result boxes. 
Read below Result Box /  Format Commands. 
 
 
 

1.7 Operators 
 
RedCrab enable you to enter numbers and functions in a simple, straightforward 
sequence. The table below shows the order in which functions in expressions are 
entered and evaluated.  
 

1 SIN( ), NOT( ), root...  and all functions  left of the argument 

2 X2, .. , 
3 join 
4 *, /, DIV, MOD, AND, SHL, SHR, INCL, EXCL, 
5 +, -, OR, XOR 

  
 

Within a priority group, RedCrab evaluates functions from left to right. 
Calculations within a pair of parentheses are evaluated first. 
 



2.0 The Toolbox
 
 

 
 

2.1 Fonts 
 

The editor used the New Courier
with Windows operating system. 
font includes Hellenic letters and special symbols.
 
 

You can toggle between the fonts by mouse click on the
buttons, left on the toolbar, or

the activated font is displayed in blue.
 
Usually the New Courier 
certain Hellenic letter or 
type in single letter of the alternative font by pressing the 

press Ctrl+P to write the character 
if the Symbol font is switched on
 
 
 
 

2.2 Font Size 
 

 

Next to the Font buttons the toolbox show the font size. You can 
change the font size with use of the combo button at the right or 

write the new font size in the box. The maximal font size is 512.
 
 
 
 
 

2.0 The Toolbox 

New Courier and Symbol fonts. They are usually included 
with Windows operating system. New Courier is the default font. The 

letters and special symbols. 

You can toggle between the fonts by mouse click on the
buttons, left on the toolbar, or press Ctrl+.(dot) keys

displayed in blue. 

 font is in use. Alternative font is generally needed for 
or special symbols. Without switching the font you can 

type in single letter of the alternative font by pressing the Ctr

to write the character ππππ or Ctrl+L to write the letter 
font is switched on, press Ctrl key to use New Courier

 

Next to the Font buttons the toolbox show the font size. You can 
the font size with use of the combo button at the right or 

write the new font size in the box. The maximal font size is 512.

 

fonts. They are usually included 
is the default font. The Symbol 

You can toggle between the fonts by mouse click on the A and ΩΩΩΩ  
keys. The button of 

font is in use. Alternative font is generally needed for 
. Without switching the font you can 

Ctrl key. Example: 

to write the letter λλλλ. Conversely, 
New Courier font. 

Next to the Font buttons the toolbox show the font size. You can 
the font size with use of the combo button at the right or 

write the new font size in the box. The maximal font size is 512. 



2.3 Superscript 
 

 

Use Superscript to write an exponent. Toggle the Superscript mode per 
mouse click on the toolbox X2 button.   

 
If you click the button when the cursor is on a character, the character under the 
cursor changed from normal letters in superscript. The Superscript mode is not 
enabled in this case, only the sign is changed. Similarly, the character can be 
reseted by superscript in normal font.  
 
As described above you can change selected cells to Superscript or reset 
 
Alternate key functions:  
 

• Function key Ctrl+6 enabled / disabled Superscript mode 
 

• Function key F3 enabled / disabled Superscript mode. 
 

• The Enter key leave the Superscript mode. 
 

• Superscript mode disabled if you enter a non alpha numeric sign .Same 
thing if you select cells. 

 

 
 

2.4 Subscript 
 

 

To write name extensions in Subscript mode click on the toolbox X2 
button.  

 
If you click the button when the cursor is on a character, the character under the 
cursor changed from normal letters in subscript. The Subscript mode is not 
enabled in this case, only the sign is changed. Similarly, the character can be 
reseted by Subscript in normal font.  
 
As described above you can change selected cells to Subscript or reset 
 
The underscore_ key and Ctrl+_ (underscore) toggles Subscript too.  
Alternate key functions:   
 



• The underscore_ key and Ctrl+_ (underscore) toggles Subscript too. 
 

• Subscript mode can be enabled / disabled using the function key F4. 
 

• The Enter key leaves the Subscript mode. 

• Subscript mode disabled if you entering a non alpha numeric sign. Same 
thing if you select cells 

 
 
 

2.5 Escape 
 

 

A mouse click on the Esc button toggles the Escape mode. You can leave 

the Escape mode with the Enter key. If the editor is in Escape and 
Superscript mode the Enter key leaves Escape mode only. 
 
Read below the description about Escape mode. 
 
 
 

2.6 DEG / RAD 
 

The DEG and RAD buttons select the input to a trigonometric 
function.  

 
DEG : input must be in degrees. 
RAD : input must be in radians. 
 

The selected button is displayed in blue. 
 
 
 

2.7 Exponent - EXP 
 

If the EXP button switched on (displayed blue), the calculator write the 
result as power of ten.   

 
 
 



2.8 Decimal Digits  
 

Next to the EXP button you can change the number of decimal 
digits in your result. To change the decimal digits click the 

up/down button right or change the number in the display. RedCrab stores 
different number of digits for fix- and floating point results 
 
 
 

2.9 Fix- / Floating point results 
 

Choose between fix- and floating point results with mouse click on 
the FIX  /  FLT  buttons. 

 

• FIX  : fix point 

• FLT : floating point 
 
 
 

2.10 Hexadecimal Output 
 

Press the HEX button to show results as hexadecimal number. RedCrab 
can display hex numbers up to 13 digits. Any numbers more than 13 

digits will be displayed as error message. 
 
Left hand zeros of positive numbers will not be displayed. Only one left hand F 
by negative numbers will be displayed with a Minus symbol. 
 
Example: 

Decimal: -2 => Hexadecimal Result $FFFFFFFFFFFFE 
Displayed as: $FE 

 
 
 

2.11 Clear 
 

The Clear function clears the worksheet and the undo memory.  
 

The Clear function clears the worksheet and the undo list, without prompting. 
Instead data are stored in the startup directory in a file named redcrab.his. If the 



Clear button was clicked by mistake, the worksheet can be restored with 
Reopen function in the File menu. 
 
 
 

2.12 Reset 
 

Reset clear all calculators output (displayed in blue). It don’t change the 
user input. It’s equal to the F7 key.   

 
 
 

2.13 Enter 
 

Enter start the calculator and display the result. It’s equal to the F8 
and Ctrl+Enter keys. 

 
 

  



3.0 Function Panel
. 
 

The following section describes the
buttons. The panels can pop up
symbols. With Move  arrows ,
or down. 
 
All the features of these panels can also be entered via the 
keyboard. Read the description of the 
Term mode. 
 
 
 
 
 

 
 
 

3.1 Number Panel
 

The following part describes the 
Alternative you can use the keyboard to execute the panel 
functions.
 

 
 
 
 

 Clears the the mathematical expression at cursor position. 
 

 Backspace. 
 

 Linefeed-Return: moves the cursor to the first col
 

  Space. 
 
All other number and operator buttons function as shown.
 

3.0 Function Panel 

following section describes the function panels 
can pop up or retract with the ‘+’ or ‘-‘ 

arrows ,the button bar can be slid up 

All the features of these panels can also be entered via the 
e description of the Escape and Long 

Number Panel 

The following part describes the Number 

Alternative you can use the keyboard to execute the panel 
functions. 

mathematical expression at cursor position.  

Return: moves the cursor to the first column at the next free row.

All other number and operator buttons function as shown. 

 panel buttons. 
Alternative you can use the keyboard to execute the panel 

 

at the next free row. 



3.2 Scientific 
 

The following part describes the Function
use the keyboard to write the functions to the editor. Use the 
Mode (Menu: Option.Long_Term).
below. 
 
 
If you are not using the 
View.Function_Panel menu.
 
 
 

Scientific Functions 
 
sin() sine  

cos() cosine  
tan() tangent  
arcsin() inverse sine

arccos() inverse cosine
arctan() inverse tangent
deg() convert radian in degrees

rad() convert degrees in radians
cot() cotangent 
exp() exponent to Euler's constant : 2.7182818284590452...

ln() natural logarithms to base  e (2,7182818284590452...)
log() logarithms base 10
log2()                  logarithms base 2

log8() logarithms 
log16() logarithms base 16

 
Extended Functions
 

E Euler's constant : 2.7182818284590452...

π constant PI: 3.1415....

ld() logarithms base 2
lg() logarithms base 10 (equal to log )

log10() logarithms base 10 (equal to log )
 
 
  

 Panel 
describes the Function panel buttons.  Alternative you can 
write the functions to the editor. Use the ESC

(Menu: Option.Long_Term). Read the description about Escape mode 

If you are not using the Function panel, you can switch this off under the 
menu. 

Functions  

 

inverse sine 

inverse cosine 
inverse tangent 
convert radian in degrees 

convert degrees in radians 
cotangent  
exponent to Euler's constant : 2.7182818284590452...

natural logarithms to base  e (2,7182818284590452...)
logarithms base 10 
logarithms base 2 

logarithms base 8 
logarithms base 16 

Extended Functions 

Euler's constant : 2.7182818284590452... 
constant PI: 3.1415.... 

logarithms base 2 
logarithms base 10 (equal to log ) 

logarithms base 10 (equal to log ) 

 

panel buttons.  Alternative you can 
ESC or LongTerm 

Read the description about Escape mode 

, you can switch this off under the 

exponent to Euler's constant : 2.7182818284590452... 

natural logarithms to base  e (2,7182818284590452...) 



3.3 Symbol Panel
 

The Symbol

the keyboard too. But problem may arise by any non 
English keyboard or language. For more information about 
the keyboard read below the description about keyboard 
configuration.
 

 
 

 

This button writes the 
to  Ctrl + 1  key. For more information read paragraph 7.6 Root.

 

 

 This button writes exponent < 2 >
Ctrl + 2 > keys.  
 
This button writes exponent < 3 > to the cursor position.
< Ctrl + 3 > keys.  
 
This button writes the symbols < *10 > to the cursor position and switched 
in the Super mode to input the exponent.
 
This button writes the 
< Ctrl + p > keys. 
 
This button writes a 
< Ctrl + / > keys. 

 
This button writes different brackets to the 
Dependant on selection (small or large), brackets will be 
displayed either in normal font size or triple row size. 

 
Details can be found under paragraph 5.0 Keyboard
 
 

Symbol Panel 

Symbol Panel contained symbols, you can write with 
the keyboard too. But problem may arise by any non 
English keyboard or language. For more information about 
the keyboard read below the description about keyboard 
configuration.     

This button writes the Root symbol to the cursor position.
key. For more information read paragraph 7.6 Root.

This button writes exponent < 2 > to the cursor position. It is equivalent to < 

button writes exponent < 3 > to the cursor position. It i
 

This button writes the symbols < *10 > to the cursor position and switched 
mode to input the exponent. 

This button writes the π – symbol to the cursor position. It

This button writes a Fraction line to the cursor position. It i

This button writes different brackets to the 
Dependant on selection (small or large), brackets will be 
displayed either in normal font size or triple row size. 

Details can be found under paragraph 5.0 Keyboard 

ou can write with 
the keyboard too. But problem may arise by any non 
English keyboard or language. For more information about 
the keyboard read below the description about keyboard 

symbol to the cursor position. It’s equivalent 
key. For more information read paragraph 7.6 Root. 

s equivalent to < 

It is equivalent to 

This button writes the symbols < *10 > to the cursor position and switched 

It is equivalent to  

It is equivalent to  

This button writes different brackets to the  cursor position. 
Dependant on selection (small or large), brackets will be 
displayed either in normal font size or triple row size.  



The Symbol panel contains extra large brackets which are not included in ANSI 

fonts. The following list shows the key codes for the English US keyboard:   
 

 

• Ctrl + '9'   ( Left round bracket 

• Ctrl + '0'   ) Right round bracket 

• Ctrl + '['   [ Left square bracket 

• Ctrl + ']'   ] Right square bracket 

• Ctrl + Shift + '[' { Left curly bracket 

• Ctrl + Shift + ']'    } Right curly bracket 
 
 
 
 

  



4.0 Programmer Panel
 

The following part describes the 
Alternative you can use the keyboard to execute the panel 
functions. Read the description about Escape mode below.
 
 

 

 
 

The following Programmer functions and operators 

Round) perform manipulation on integer operands. If the operands real 

type numbers, the values are rounded toward zero. 

 
 
 

Operator 
 
 
 

4.1 Div 
 
The DIV operator returns the result of an integer number division without 
remainder. If floating point numbers are entered, the 
digits after the decimal point before executing the division 
 
Example: 
 
     11   DIV 3   = 3

11.2 DIV 3.9 = 3

 
 
 

4.2 Mod 
 
The MOD operator returns the remainder of the division of two integer numbers. 
If floating point numbers are entered, the 
the decimal point before executing the division 
 
Example: 
 

Programmer Panel 

The following part describes the Programmer
Alternative you can use the keyboard to execute the panel 
functions. Read the description about Escape mode below.

Programmer functions and operators (except Int, Frac and 

perform manipulation on integer operands. If the operands real 

type numbers, the values are rounded toward zero.  

operator returns the result of an integer number division without 
remainder. If floating point numbers are entered, the DIV operator cuts off all 
digits after the decimal point before executing the division DIV. 

3   = 3 

3.9 = 3 

operator returns the remainder of the division of two integer numbers. 
If floating point numbers are entered, the MOD operator cuts off all digits after 
the decimal point before executing the division MOD. 

Programmer panel buttons. 
Alternative you can use the keyboard to execute the panel 
functions. Read the description about Escape mode below. 

(except Int, Frac and 

perform manipulation on integer operands. If the operands real 

operator returns the result of an integer number division without 
operator cuts off all 

 

operator returns the remainder of the division of two integer numbers. 
operator cuts off all digits after 



     11   MOD 3   = 2 

     11.7 MOD 3.9 = 2 

 
 
 

4.3 And 
 
The logical AND operator performs bitwise AND manipulation on integer 
operands  
 

Example:     Z = X AND Y 

 
 
 

4.4 Or 
 
The logical OR operator performs bitwise OR manipulation on integer operands. 
 

Example:   Z = X OR Y 
 

 

 

4.5 Xor 
 
The logical XOR operator performs bitwise XOR manipulation on integer 
operands.  
 

Example:   Z = X XOR Y 

 
 
 

4.6 Shl / Shr 
 
The SHL or SHR operator shift bitwise left or right manipulation on integer 
operands. The value of Y is interpreted modulo 32. Thus for example, if X is 40, 
X is interpreted as 8 because 40 mod 32 is 8. 
 

Examples:   Z = X shl Y 
  9 shl 2 = 36 

 



 
 

4.7 INCL 
 
The INCL operator adds a bit to the integer operands.  
 

Example:   Z = X INCL Y 
 

In the example above INCL sets the bit number Y in operant X 
 

Example:   8 INCL 3 = 12 

 
 
 

4.8 EXCL 
 
The EXCL operator excludes a bit from an integer operands.  
 

Example:   Z = X EXCL Y 
 

In the example above EXCL clears the bit number Y in operant X 
 

Example:   15 EXCL 4 = 7 

 
  
 

Functions 
 
 
 

4.9 Not 
 
The logical NOT function performs bitwise negation on integer operands.  
 

Example:   Z = NOT(X) 

 
 
 

4.10 TRUNC 



 
The Trunc function truncates a real
values are rounded toward zero.
 

Example:   TRUNC(123.67) = 123

 
 
 
 

4.11 HEX 
 
This button writes the $ symbol for hexadecimal input to cursor position. More 
information can be found under paragraph 1.9 Hexadecimal Input.
 
 
 
 

5.0 Standard Functions
 

  

 

 

 

5.1 Round 

Round returns a value rounded to the nearest whole number. 

Example:  x=round(y)

 
round(2.6)=

 

  round(3.5)=

 

  round(2.5)=

If y is exactly halfway between two whole numbers, the result is always the even 
number. This method of rounding is often 

 

function truncates a real-type value to an integer-
rounded toward zero. 

TRUNC(123.67) = 123 

symbol for hexadecimal input to cursor position. More 
information can be found under paragraph 1.9 Hexadecimal Input.

Standard Functions Panel 

value rounded to the nearest whole number.  

(y) 

(2.6)=3 

(3.5)=4 

(2.5)=2 

is exactly halfway between two whole numbers, the result is always the even 
number. This method of rounding is often called "Banker's rounding".

-type value. The 

symbol for hexadecimal input to cursor position. More 
information can be found under paragraph 1.9 Hexadecimal Input. 

is exactly halfway between two whole numbers, the result is always the even 
called "Banker's rounding". 



  

5.2 Int 

Int returns the integer part of a value; that is, the value rounded toward zero. 

Example:  x= int(y) 

x=int(4.67)=4 

 
 
 

5.3 Frac 
 
Frac returns the fractional part of an argument.  
 
Example: x=frac(y) 

 

  x=frac(4.67)=0.67 

 
 
 

5.4 Rnd 
Random  
Rnd returns a random integer number within the range 0 <= X <= Range.  
 
Example: x=rnd(y) 

 
 
 

5.5 URnd 
 
URnd fills a field with a series of random numbers between 0 and the highest 
argument of the field. In contrast to Rnd, which also can be used for fields, 
URnd returns a set of unique numbers. 
 
Example: a=urnd([1..5,45])  
  b=urnd([44..45]) 

   
Both examples return a list of six different numbers between 1 and 45. 



 
 
 

5.6 Abs 
 
Abs returns the absolute value of numbers and fields. 
 
Example: x=abs(y) 

 

  x=abs(4.56) =4.56 

 
  x=abs(-4.56)=4.56 

 

 

 

  



6.0 Fields Panel
 
 

Operators 
 
 

6.1 Join 
 
The operator Join connects
result contains the sum of the rows
 

Excample: a = [1..5] = 
                      

   b = [6..10]

   

  c = a join

     

 
If the fields are different lengths
 
  x = [11..18] = 

 

  d = x join

     

     

 
 
 

6.2 Mulx 

 
Mulx is an operator for multiplication of matrices
with Mulx is possible only if the 
same as the number of rows of the right matrix.
 
 

Beispiel: 
 

  
 
 

Panel 

connects one or two-dimensional fields with each other
of the rows of the first and second operand.

a = [1..5] =   1 2 3 4 5           

                       

= [6..10] =  6 7 8 9 10          

join b = 1 2 3 4  5 

   6 7 8 9 10 

are different lengths, the shorter field is filled with zeros.

..18] = 11 12 13 14 15 16 17

join c = 11 12 13 14 15 16 17

    1  2  3  4  5  0  0

    6  7  8  9 10  0  0

perator for multiplication of matrices. Multiplication of two matrices 
is possible only if the number of columns of the left matrix is the 

same as the number of rows of the right matrix. 

fields with each other. The 
operand. 

            

           

zeros. 

11 12 13 14 15 16 17 

11 12 13 14 15 16 17 

1  2  3  4  5  0  0 

6  7  8  9 10  0  0 

Multiplication of two matrices 
number of columns of the left matrix is the 



The result is a matrix whose entries are given by dot product of the 
corresponding row of the left operand and the corresponding column of the right 
operand: 
 
   (1*2 + 2*3 + 3*6) (1*4+ 2*5 + 3*8) 

   (4*2 + 5*3 + 6*6) (4*4+ 5*5 + 6*8) 

   (7*2 + 8*3 + 9*6) (7*4+ 8*5 + 9*8) 

 

More Information about multiplication of matrices:  
 
 1) http://en.wikipedia.org/wiki/Matrix_multiplication 
 
 2) The description of the function Trans. 
 
 
 

6.3 Fill 
 
The result of the operator Fill is a data field the size of the left operand. The 
field contains values specified by the right operand. 
 
Example: x = [1..5] fill 8 = 8 8 8 8 8 

 
 
 

6.4 Patt 

 
The result of the operator Patt is a data field the size of the left operand. The 
field contains continuous values of the right field operand. 
 
Example: x = [1..10] patt [1,1,2] = 1 1 2 1 1 2 1 1 2 1 
 
 
 

6.10 Trans 
 
Trans producing the transpose of a matrix AT, which is computed by swapping 
columns for rows in the matrix X. 

 



Example:  

   

 

  

  trans(x) =

  

 

 
For more information read: 
 
 

6.11 Min , Max
 
Min (minimum) and Max

maximum value of one– or multidimensional field
 

Example:: z=min(x) 

 

x= [9,7,2,8,12,3,5]  

   

min(x) = 

   

max(x) = 

 

 
 

6.12 Count  
 
Count returns the number of elements of 
    
Example: z=count(x)

 
x= [9,7,2,8,12,3,5]  

   

count(x) = 

 
 

 

  1 4 7  

= 2 5 8 

  3 6 9 

For more information read: http://en.wikipedia.org/wiki/Matrix_transpose

Min , Max 

Max (maximum) return the value at which the m
or multidimensional fields. 

 

x= [9,7,2,8,12,3,5]   

min(x) = 2 

max(x) = 12              

ns the number of elements of one– or multidimensional field

(x) 

x= [9,7,2,8,12,3,5]   

(x) = 7 

http://en.wikipedia.org/wiki/Matrix_transpose 

at which the minimum or 

or multidimensional fields. 



 

6.13 Aver 
 
The function Aver returns the mean values of successive elements of fields. The 
result is always one element smaller than the original field. 
 

Example: a = [1..5]
2
 = 1 4 9 16 25 

   b = aver(a) = 2.5 6.5 12.5 20.5 

 
 
 

6.14 AddIn 
 
The operator AddIn returns a data field with a linear series of numbers. The 
length of the field corresponds to the left operand. The first number is taken 
from the first element of the left operand. The following values are incremented 
by the value of the right operand. 
   

Example: [4..8] addin 0.5 = 4.0 4.5 5.0 5.5 6.0 

 

 

The left operand’s first element defines the start value; the following values 
have no significance. They are place holders to determine the size of the field. 
The following example shows therefore the same result as above. 
 

Example: [4..0] addin 0.5 = 4.0 4.5 5.0 5.5 6.0 

 

 

A descending sequence of numbers generated by a negative operand. 
 

Example: [4..8] addin -0.5 = 4.0 3.5 3.0 2.5 2.0 

 
 
 

6.15 AddTo 
 
The operator AddTo returns a data field that contains a linear series of numbers. The 
series begins with the first value of the left operand and is incremented by the 
value of the right operand to the next value of the left operand. 
 
 



 Example:  
[4,7] addto 0.5= 4.0 4.5 5.0 5.5 6.0 6.5 7.0  

 
 [4,1] addto 0.5= 4.0 3.5 3.0 2.5 2.0 1.5 1.0 

 
[4,6,5] addto 0.5= 4.0 4.5 5.0 5.5 6.0 5.5 5.0                        

 
 
 

6.16 AddOn 
 
The function AddOn adds any value of a continuous series of numbers to the 
next value. 
 

Example: addon([10,30,25,-10,15]) = 10 40 65 55 70 

 
 
 

6.17 MulIn 
 
The operator MulIn returns a data field with a logarithmic series of numbers. 
The number of values corresponds to the numbers of the left operand. The first 
number is taken from the first element of the left operand. The following values 
are each the product of multiplication by the right operand. 
 

Example: [2..8] mulin 2.0= 2 4 8 16 32 64 128 

 
 
The left operand’s first element defines the start value; the following values 
have no significance. They are place holders to determine the size of the field. 
The following example shows therefore the same result as above. 
 

Example: [2..-4] mulin 2.0= 2 4 8 16 32 64 128 

 
 
Descending sequence of numbers generated by a value  < 1. 
 
[2..8] mulin 0.5= 2.0 1.0 0.50 0.25 0.13 0.06 0.03 
 
 
 



6.18 MulTo 
 
The operator MulTo returns a data field with a series of logarithmic numbers. 
The series begins with the first value of the left operand and is gradually 
multiplied by the value of the right operand till the value of the next operand is 
reached. 
 
Example:   

[1,150] multo 2 = 1 2 4 8 16 32 64 128 
 
 [150,3] multo 0.5 = 150 75 37.5 18.8 9.38 4.69 

 
For ascending order, right operand must be >, for a descending order the right 
operand must be < 1. Negative values and the values 0 and 1 are not allowed. 
 
    
 

6.19 MulAd 
 
The operator MulAd returns a series of numbers where each value of the left 
operand first multiplied by the right operand, and added to the next value. 
 
Example: 
x=[1..5] fill 100 =100.00 100.00 100.00 100.00 100.00 

 

y=x mulad 1.1 = 110.00 231.00 364.10 510.51 671.56    

 
The right operand can be a one-dimensional field. 
 
 
 

6.30 Dim 
 
The Dim function returns the number of dimensions of a multi dimensional data 
field. 
 

Example: X = [1..4;12..15] 

  Dim(x) = 2 



 
 
 

6.31 Rows 
 
The function Rows returns the number of rows of a two dimensional data field. 
 

Example: x = [1..4;12..15] 
r = Rows(x) = 2 

 
 
 

6.32 Cols 
 
The function Cols returns the number of columns of a two dimensional data 
field. 
 

Example:  x = [1..4;12..15] 
c = Cols(x) = 4 

 
 
  



7.0 Statistics Panel 
 
 
 
 

7.1 Sum 
 
The function Sum returns the sum of the elements in fields. The function can be 

called by the Greek letter ΣΣΣΣ.... 
 
Example: z = sum(x) 

 

X = [9,7,2,8,12,3,5]   

 

  sum(x) = 46 

  Σ(x) = 46 

 
 
 

7.2 Prod 
 
Prod returns the product of all elements of fields. 
 

Example: z=prod(x) 

 

X = [9,7,2,8,12,3,5]   

 

  prod(x) = 181440 

 
 
 
 

7.3 Cusum 
 
The function CUSUM returns the calculation of a cumulative sum of one- 
dimensional fields. 
 
Example: z = cusum(x) 



 

cusum([2,4,7,3,9])= -3 -4 -2 -4 0                

 

For more information read :  http://en.wikipedia.org/wiki/CUSUM 
 
 
 
 

7.4 Sort, DSort 
 
Sort sorts field elements from low to high values (sort ascending). DSort sorts 
field elements from high to low values (sort descending). Complex fields are 
sorted based on first row values.  
 
Example:  z = sort(x) 

 
 
 

7.5 Median 
 
 Median returns  the median value of fields. In multidimensional fields the result 
is the median of all elements. 
 
Example: z = median(x) 

 
 
 

 7.6 Mean 
 

The result of Mean is the mean value of field. In multidimensional fields the 
result is the mean of all elements. 
 

Example: z = mean(x) 

 
 
 



7.7 Vari / SVari 
 
The result of Vari and SVari  is the variance of values in one-dimensional fields. 
Use Vari if the field contains all evaluated data. SVari is more applicable for 
samples. 
 
Example: z = vari(x) 

 
For  more infomation read: http://en.wikipedia.org/wiki/Variance 
 
 
 
 

7.8 StDev / SStDev 
 
StDev returns the standard deviation of values in one–dimensional fields. Use 
StDev if the field contains all evaluated data. SStDev is more applicable for 
samples. 
 
Example: z = stdev(x) 

 
For more information, read: http://en.wikipedia.org/wiki/Standard_deviation 
  

 

 
 

7.9 Diff 
 
Diff returns the difference values of successive elements of fields. Diff subtracts  
the first field element from the second, the second element from the third, etc.. 
The field of the difference values is always one element shorter than the original 
field. 
 
Example: z = diff(x) 

 
X = rnd([11..20]) = 15 19 18 2 11 12 20  

 

diff(x) = 4 -1 -16 9 1 8  

 
 

 



7.10 LQuart 
 
LQuart returns the value of the first quartile (lower quartile) of a sorted list. In 
the following example in a field of 10 elements, the position of the first quartile 
is (10 × ¼) = 2.5, rounded up to 3. 
 
Beispiel: lquart([3,6,7,8,8,10,13,15,16,20]) = 7 

 
 
 

7.11 UQuart 
 
UQuart returns the value of the third quartile (upper quartile) of a sorted list. In 
the following example, in a field of 10 elements the position of the third quartile 
is (10 × ¾ ) = 7.5, rounded up to 8. 
 

Example:  lquart([3,6,7,8,8,10,13,15,16,20]) = 15 

 

 

 

7.12 QRan 
 

QRan results the area from the first to 3rd quartiles of a sorted list. The 
following example shows the result of a field with 10 elements. 
 

Beispiel: lquart([3,6,7,8,8,10,13,15,16,20])  

  = 7 8 8 10 13 15 

 

 

 
 
 

8.0 Keyboard 
 
The keyboard inputs in the following description correspond to the English 
keyboard and Windows regional and language option English-US. When using a 
non-English keyboard or language, some functions are acquired with other key 
combinations. This concern most of the Ctrl key functions. In the attachment of 
this manual you will find pictures about key codes of different keyboards. Read 
the description below about keyboard configurations. 



  
 

 
Esc 

 
Switch to escape mode. 

To exit escape mode: press enter key or 
bracket open  

 
 
 
 
Enter 

-  Exit escape mode  

-  Exit Superscript 

-  Exit Subscript 

-  Moves cursor to numerator, if this position is end of fraction bar, 

-  Moves cursor to denominator, if this position in the numerator row. 

-  Moves cursor to end of fraction, if this position at the denominators row. 

Enter + Ctrl Display result  Equal to the Function  panels Enter button  

Enter + Shift Line feed- return : move the cursor to the first used column in the next row 

Ctrl + (Shift) switch to alternative font  

Ctrl +  .  Toggle ANSI / Symbol font   

Ctrl +  ,  Toggle on / off Subscript 

Ctrl + _  Toggle on / off Subscript (equal Ctrl + ,) 

Ctrl + Shift +  , Toggle on / off Superscript (exponent)  

Ctrl + 6  Toggle on / off  Superscript (equal Ctrl +  Shift + ,) 

Ctrl + 9 large round bracket open  

Ctrl + 0 large round bracket close 

Ctrl + [ large square bracket open 

Ctrl + ] large square bracket close 

Ctrl + Shift + { large curly bracket open  

Ctrl + Shift + } large curly bracket close 

Ctrl + / fraction line  

Ctrl + 1 root  

Ctrl + 2 Exponent 2  

Ctrl + 3 Exponent 3  

Ctrl + 4 Integral Formula 

Ctrl + Shift + 4 Integral Symbol 

Ctrl + 5 Function Symbol 

Insert Insert a column at cursor position 

Insert + Shift Insert a row at cursor position 

Delete Delete a column at cursor position 

Delete + Shift Delete a row at cursor position 

Ctrl + Csr left Page left  
Ctrl + Csr right Page right  
Ctrl + Csr up Scroll up  
Ctrl + Csr down Scroll down  
Ctrl + Page up Move cursor to the first row of the screen 

Ctrl + Page down Move cursor to the last row of the screen 

  

F2 Marked/Unmarked the selected range or cursor position as remark 

F3 Enable or disable  Superscript  mode. 

F4 Enable or disable  Subscript mode. 

F5 AC -  Clears the the mathematical expression at cursor position. 

F6 Clear - clear all 

F7 Reset – clear the output of the calculator 

F8 Enter – starts the calculator 



  

  

Ctrl + A α Α Alpha 

Ctrl + B β Β Beta 

Ctrl + C χ Χ Chi Copies the selected area  * 

Ctrl + D δ ∆ Delta 

Ctrl + E ε Ε Epsilon 

Ctrl + F φ Φ Phi 

Ctrl + G γ Γ Gamma 

Ctrl + H η Η Eta 

Ctrl + I ι Ι Iota 

Ctrl + J ϕ  Phi (alt.) 

Ctrl + J  ϑ Theta (alt.) 

Ctrl + K κ Κ Kappa 

Ctrl + L λ Λ Lambda 

Ctrl + M µ Μ Mu 

Ctrl + N ν Ν Nu 

Ctrl + O ο Ο Omicron 

Ctrl + P π Π Pi 

Ctrl + Q θ Θ Theta 

Ctrl + R ρ Ρ Rho 

Ctrl + S σ Σ Sigma 

Ctrl + T τ Τ Tau 

Ctrl + U υ Υ Upsilon 

Ctrl + V ϖ  Pi (alt.) Insert text from clipboard * 

Ctrl + V  ς Sigma (alt.) 

Ctrl + W ω Ω Omega 

Ctrl + X ξ Ξ Xi Cut and copies the selected area * 

Ctrl + Y ψ Ψ Psi 

Ctrl + Z ζ Z Zeta 

 
*) 
Ctrl + C copies the selected area to clipboard. Ctrl + X cuts the selected area and 
copies it to the clipboard. If no area is selected, the corresponding Greek letter is 
written. 
 
Ctrl + V writes the text from the clipboard to the cursor position if, immediately 
before a text with Ctrl + C / X was copied, otherwise the corresponding Greek 
letter is written. 
 
The decimal key below the numeric keypad (point / comma) produces a decimal 
point always, regardless of the country setting. 
 
 



The Menu Bar 
 
 

10.0 File Menu 
 
 

10.1 Open  
 
Click Open on the File menu. In the Navigation pane, click folder or drive that 
contains the file that you want to open. You can only load file that are saved 
with RedCrab before, with the file extension *.rcc. 
 
 
 

10.2 Reopen 
 

Reopen function opens the last deleted file. 
 
The Clear function clears the worksheet and the undo list, without prompting. 
Instead data are stored in the startup directory in a file named redcrab.his. If the 
Clear button was clicked by mistake, the worksheet can be restored with 
Reopen function. 
 
 
 

10.3 Save 
 

If you are saving a changed file click Save on the File menu or press 
Ctrl+Alt+S.  
 
 
 

10.4 SaveAs 
 

If you are saving the file for the first time use SaveAs on the File menu, the file 
browser prompt for a file name. 
 
  



 
 

10.5 Print a worksheet
 
The right picture shows the
dialog box. By default, 64 columns
per page are printed. The number 
of rows depends on the size of the 
page. By entering a 
value, you can increase or 
decrease the printer output.
 

With the button All you print the 
working area of the worksheet 
from position (1.1). If necessary,
the worksheet is split into
pages. The layout of the pages
shown in the following table.
 
If the button Page is selected, individual 
pages can be printed. 
 
With the button Selection
selected area of the worksheets
print-out is positioned on the top of 
page. Center Selection
selected area at the center 
 
With the check box Fit to page
print-out is adjusted to the page size. 
The Columns per Page setting is ignoring. A small selected area can so enlarged 
to the width or height of the page. Similarly, a print
several pages are reduced to one page.
 

• 10.5.1 Page Setup
 
With Page Setup you can set the margins width and paper format
 

• 10.5.2 Printer Setup 
 
Select the printer and the printer settings

Print a worksheet 

shows the print 
64 columns 

The number 
size of the 
 different 

increase or 
printer output. 

you print the 
worksheet 

If necessary, 
split into several 

of the pages is 
table. 

is selected, individual 

Selection you can print 
of the worksheets. The 

on the top of the 
Selection prints the 

 of the page. 

Fit to page the 
out is adjusted to the page size. 

setting is ignoring. A small selected area can so enlarged 
t of the page. Similarly, a print-out what normally occupied 

several pages are reduced to one page. 

.1 Page Setup 

With Page Setup you can set the margins width and paper format

Printer Setup  

Select the printer and the printer settings. 

 

Page 1 
 

Column 1..64 
Row 1..68 

 

Page 2
 
Column 65..128

Row 1..68

 

Page 4 
 

Column 1..64 
Row 69..136 

 

Page 5
 

Column 64..128
Row 69..136

setting is ignoring. A small selected area can so enlarged 
out what normally occupied 

With Page Setup you can set the margins width and paper format. 

e 2 

65..128 
1..68 

 

Page 3 
 

Column 129..192 
Row 1..68 

e 5 

64..128 
69..136 

 

Page 6 
 

Column 129..192 
Row 69..136 



11.0 Edit Menu 

 
 
 

11.1 Undo / Redo 
 

You can undo and redo your action by clicking Undo or Redo on the Edit menu.  
You can undo and redo up to 100 actions. Undo and Redo is not possible by 
imported object like bitmaps. 
  
 
 

11.2 Copy / Paste 
 
With the Copy and Paste functions you can copy and insert data within RedCrab 
or from/to external programs. The Copy function copies the selected fields to the 
clipboard. Texts from/to external programs will posted as unformatted ASCII 
text.  
 
Within RedCrab the data are copied in format style. Exception: square root. 
With Paste function only the symbol of the square root is inserted. The range 
belonging to this field must be selected at the new position again. Hence errors 
can be avoided, e.g. only the sub range square of a root is copied and inserted to 
other position. 
 
 
 

11.3 Paste to Box 
 
For complex technical calculations, it may be useful to include technical 
drawings to mathematical formulas. With Paste to Box on menu Edit you can 
import images and formatted texts from external programs. The image or the 
formatted text is inserted into a box and can be positioned freely. Multiple 
images or text boxes can be inserted. The amount is limited only by resources of 
your computer. 
 
To change a box position, move the mouse pointer on a box, press the left 
mouse button and pull with pressed mouse button the box into the desired 
position.  
 



Text and Images boxes are deleted with Delete on a popup menu. Open the 
menu with click on right mouse button, and then choose Delete.  
 
Information about the import of images and text files can be found below under 
Menu Insert. 
 
 
 

11.3.1 Text Box  
 
To edit the text or change the size of text box, text box must be active. Activate 
the text box with double-click of the left mouse button. The background of the 
activated text box will displayed coloured and the text cursor is indicated. 
 

To change the size of the text box, position the mouse pointer on the lower right 
corner of the box and drag the box with pressed right mouse button to the 
desired size. The area to draw the text boxes is displayed with a NW- mouse 
pointer. Information for editing text can be found below at Chapter text editing. 
 
Click the right mouse button to open the text box’s popup menu. The text box 
must be activated first 
 
Popup Menu: 
 

• Word Wrap: Word wrap on / off 

• Lock Text: text edit is disabled. 

• Scroll Bars: scroll bars on / off 

• Font: open Font Dialog to change the font type, size and colour. 

• Delete Text Box: delete the text box.  
 
 
If the editing of the box and text is completed, deactivate the box with double-
click on the left mouse button. 
 
 
 
 



11.3.2 Text Editing 
 
For editing of text the following table shows a list of keyboard instructions. 
 

Keys Operations 

  
Ctrl + Tab Tab 

Ctrl + Number Pad 5 Select all 

Ctrl + A Select all 

Ctrl + E Center alignment 

Ctrl + J Justify alignment 

Ctrl + R Right alignment 

Ctrl + L Left alignment 

Ctrl + C Copy 

Ctrl + V Paste 

Ctrl + X Cut 

Ctrl + Z Undo 

Ctrl + Y Redo 

Ctrl + '+'  Superscript 

Ctrl + '=' Subscript 

Ctrl + 1 Line spacing = 1 line. 

Ctrl + 2 Line spacing = 2 lines. 

Ctrl + 5 Line spacing = 1.5 lines. 

Ctrl + ' (apostrophe) Accent acute 

Ctrl + ` (grave) Accent grave  

Ctrl + ~ (tilde) Accent tilde 

Ctrl + ; (semicolon) Accent umlaut 

Ctrl + Shift+6 Accent caret (circumflex) 

Ctrl + , (comma) Accent cedilla 

Ctrl + Shift + ' (apostrophe) Activate smart quotes 

Backspace Delete previous character. 

Ctrl + Backspace Delete previous word.  

F16 Same as Backspace. 

Ctrl + Insert Copy 

Shift + Insert Paste 

Insert Overwrite 

Ctrl + Left Arrow  Move cursor one word to the left. 

Ctrl + Right Arrow Move cursor one word to the right. 

Ctrl + Left Shift Left alignment 

Ctrl + Right Shift Right alignment 

Ctrl + Up Arrow Move to the line above. 

Ctrl + Down Arrow Move to the line below. 

Ctrl + Home Move to the beginning of the document. 

Ctrl + End Move to the end of the document. 

Ctrl + Page Up Move one page up. 

Ctrl + Page Down Move one page down. 

Ctrl + Delete Delete the next word or selected characters. 

Shift + Delete Cut the selected characters. 



Alt + X 
Converts the Unicode hexadecimal value preceding the insertion 
point to the corresponding Unicode character. 

Alt + Shift + X 
Converts the Unicode character preceding the insertion point to 
the corresponding Unicode hexadecimal value. 

Alt + 0xxx  
(Number Pad)  

Inserts Unicode values if xxx is greater than 255.  
Inserts ASCI values if xxx is less than 256  

Ctrl + Shift + A  Set all caps. 

Ctrl + Shift + L  Fiddle bullet style. 

Ctrl + Shift + Right Arrow increase font size 

Ctrl + Shift + Left Arrow decrease font size 

 
 
 

11.4 Cut/Delete 
 
With functions Cut and Delete on the Edit menu the selected range on the 
computing sheet is deleted. With Cut the range is copied in the clipboard and 
can be inserted in other position again.  
 
 
 
 

12.0 View Menu 

 
 
 

12.1 Grid 
 

You can show or hide gridlines. Use Grid on the View menu to switch the grid 
on / off. 
 
 
 

12.2 Undock Function Panel 
 
 The function panel can be displayed within the main window or as new 
window.  
 
This function is activated through Menu Undock_Function_Panel or by double 
clicks on the function panel. 
 
 



 

12.3 Function Panel 
 

Switch the Function Panel on / off with click on Function Panel  on the View 

menu 
 
 
 

12.4 Virtual Keyboard 
 

Switch the Virtual Keyboard on / off with click on Virtual Keyboard  on the 
View menu. 
 
 
 

13.0 Insert Menu 

 
 
 

13.1 Image File 
 

Load a graphic file. For complex technical calculations, it may be useful to 
include technical drawings to mathematical formulas. Click Image File in the 
Insert menu to open the image file browser and select the image file. RedCrab 
can imports photos from Jpeg files (*.jpg) and  Windows Bitmap files (*. bmp). 
The Jpeg format is not suitable for technical drawings. It creates blurred images 
around edges and errors in the transparency of the images. When RedCrab 
saving files that includes bitmap images, RedCrab compressed images without 
loss and they are usually smaller than jpeg format. 
 
Inserted image is positioned on the top left of the page. You can move it by 
clicking the left mouse button on the image and drag, while holding down the 
mouse button, the image to the desired position. 
 

Text and Images boxes are deleted with Delete on a popup menu. Open the 
menu with click on right mouse button then choose Delete.  
 
Click the right mouse button to open the image box’s popup menu.  
 
Popup Menu: 



 

• Transparent: displays the image with a transparent background. This 
function works only if the image has a background defined and all 
textboxes in deactivated mode. 

• Delete: delete the box.  

 
 
 

13.2 Text File 

 
For documentation purposes, text files can be inserted in any position in text 
box. 
 
To load a text file click Text File on menu Insert. It opens a file browser to 
select a file. Files of the type TXT (unformatted text) or RTF (Rich Text 
Format) can be inserted. 
 
The text is inserted in a text box positioned on the top left corner at the 
calculation sheet. To move the text box, position the cursor on the text box and 
press the left mouse key. Then drag the box in the desired position by holding 
down the left mouse button. . Multiple text boxes can be inserted. The amount is 
limited only by resources of your computer. 
 

Text and Images boxes are deleted with Delete on a popup menu. Open the 
menu with click on right mouse button then choose Delete.  
 
Text boxes are always inserted in a preset size. You can resize the box according 
to text size. It is possible to edit the texts in the text box. For information about 
resize and edit textboxes read Textbox Editing above. 
 
 
 

13.3 New Textbox 
 
With New Textbox on menu Insert an empty text box will be inserted. To input 
text the box must be activated with a double click of the left mouse button. For 
more information about text box editing read the capital Text Box above. 
 
 
 



13.4 Textbox to Image 
 
The function text Box to Image converts a text box into an image box. The 
advantage of a graphics box is: 
 

1) The texts cannot be changed. 
2) The formatted text is displayed in original format (similar to a PDF file), 

even if the displayed font is not installed on the user computer. 
 
The function should only be used if it makes sense. By changing the format of 
the file, the file size will be larger.  

! Important: This function cannot be reversed! 

 
 
 

13.5 Show Textbox 
 
The function Show Text box in the menu Insert displayed all text boxes with a 
coloured background. The function is helpful in allocating an empty text box or 
showing the exact positioning. 
 
 
 

13.6 Result box 

 
With Result boxes you can display formatted results of calculations on any work 
sheet position.  Click Result box on the Insert menu to open a result box. 
 
Example: If the result of a calculation is a distance of 3650 meters, RedCrab 

write:  = 3650 or: = 3.65 10
3 

in the work sheet. 

 

A result box can show the display format:  = 3.65km. 

 
A result box can be displayed on any position. So you can insert results directly 
on technical drawings. Result text can be displayed vertically, horizontally or 
inclined position. The size of the box is auto fitted to the size of the text. 
 
 
 



13.6.1 Popup Menu  
 
With click of the right mouse key you open the result 
box popup menu. The list below show an overview of 
the various functions. 

• ference opens the Reference dialog box to enter 
the reference variable and pre setting of the 
display format .  

 

• Font opens the Font dialog box. Adjustment is 
dependant from the setting of the sync function 
(see below). 

 

• Background opens a colour dialog box to choose 
the result box background colour. 

 

• Transparent: displays the result box with a 

transparent background.  

 

• Send to Back: moves the top object to other object below. 
 

• Bring to Front: ensures that a box is visible or to reorder overlapping 
boxes within a worksheet. 
 

• Undocked 
 

• Vertical: displays the result box content vertically. 
 

• Angle: opens a dialog box to adjust the slant of results display. It can be 
an angle in the range of + / - 90 degrees, adjustable in 0.1 degree 
increments. 

 

• Grid sync: synchronizes the box to the worksheet. 
 

• Object sync: synchronizes the box to a Text or Image box. 
 

• Non sync: size and position of the box are freely adjustable. 
 

• Delete: deletes the box. 
 
 
 



13.6.1.1 Reference und Format  
 
The Reference popup menu opens the Reference dialog box to enter the 
reference variable and the display format instruction.  
 
The row Reference variable show the name of the 
variable whose value is displayed in the box. 
  
To determine the variable you select here the 
name on the worksheet. Then click the Paste 

button in the dialog box. The name is accepted 
and pasted to the reference row. 
 
In the first example below the format row are 
empty. The Result box shows the same display 
format as the worksheet. But instead of the power 
of ten, the box displays the SI-Prefix ,m’. The 
result box background is displayed gray. 
 
 

 
 
 

13.6.1.2 SI-Prefix 

Result boxes used SI prefixes instead of exponents to reduce the number of 
zeros shown in numerical quantities before or after a decimal point. For 
example, an electrical current of 0.001ampere, or 10-3 of an ampere, is written 
by using the SI-prefix m (milli) as 1 milliampere or 1mA. The SI prefixes are 
standardized by the International Bureau of Weights and Measures (IBWM). 

The list below shows the prefixes which RedCrab used. 

 

 Prefix  Decimal Short scale Long scale 

Y yotta  1024  1.000.000.000.000.000.000.000.000 Septillion Quadrillion 

Z zetta 1021  1.000.000.000.000.000.000.000 Sextillion Trilliard 

E exa 1018  1.000.000.000.000.000.000 Quintillion Trillion 



P peta 1015  1.000.000.000.000.000 Quadrillion Billiard 

T tera 1012  1.000.000.000.000 Trillion Billion 

G giga 109  1.000.000.000 Billion Milliard 

M mega 106  1.000.000 Million 

k kilo 103  1000 Thousand 

h hecto 102  100 Hundred 

- - - 1 One 

d deci 10−1  0,1 Tenth 

c centi 10−2  0,01 Hundredth 

m milli 10−3  0,001 Thousandth 

µ  micro 10−6  0,000.001 Millionth 

n nano 10−9  0,000.000.001 Billionth Milliardth 

p pico 10−12  0,000.000.000.001 Trillionth Billionth 

f femto 10−15  0,000.000.000.000.001 Quadrillionth Billiardth 

a atto 10−18  0,000.000.000.000.000.001 Quintillionth Trillionth 

z zepto 10−21  0,000.000.000.000.000.000.001 Sextillionth Trilliardth 

y yocto 10−24  0,000.000.000.000.000.000.000.001 Septillionth Quadrillionth 

 

 

13.6.1.3 Formatting 
 
In the Reference dialog box (described above) you can input control characters 
in the Format row to control and completion of the display format. For the 
example above among SI prefixes, the two characters, #A' are entered. The 
pound sign (#) is a placeholder for the result and prefix: 12m (12 million), the A 
stands for the unit ampere. The box shows the result: 12mA. 
 
Before and after the pound you can insert any character. An exception is the 
backslash symbol (\) because it has a special function. 
 
Examples: 
 

Result Formatted Text Result Box Display 
0.012  12m 

0.012 #A 12mA 

0.012 =  # A = 12 mA 



125 US$ # US$ 125 

0.012 Current: #A~ Current: 12mA~ 

 
 
 

13.6.1.4 Specification of a prefix 
 
If the result of an expression is the distance between two points, the control 
symbols, #m’ displays the result in meters (m). 
 
Examples: 
 

 Result:  365   Display: 365m 

 Result:  3600  Display: 3.6km 

 Result: 3650000  Display: 3.65Gm 
 
The displayed result: 3.65Gm (Giga meter) is correct, but unusual. Therefore, in 
RedCrab you can preset certain prefixes. This is written in the format text after 
the pound, a backslash (\) followed by the preferred prefix. In this example, the 
issue is better suited to kilometres, so the two characters ‘ \k’ are inserted. The 
format string looks like this: '# \km'. 
 
Examples: 
 

 Result:  365   Display: 0.365km 

 Result:  3600  Display: 3.6km 

 Result: 3650000  Display: 3650km 

 
RedCrab also has the option to select a group of prefixes or to determine an 
upper or lower limit. A '+' sign in front of the prefix determined the upper limit. 
The formatting string, # \+km ' shows all results of 1000 or above in kilometres. 
Results under 1000 are displayed according to the value in meters or millimetres 
etc. A '-' sign in front of the prefix determined the lower limit. The two limits 
can also be combined. The following examples show the output at a range 
setting of millimetres to kilometres. 
 



Example:  Format = ‚# \-m\+k m‘ 
 

 Result:  3650000  Display:  3650 km 

 Result:  36500  Display:  36.5 km 

 Result:  365   Display:  365 m 

 Result:  3.65  Display:  3.65 m 

 Result:  0.0365  Display:  36.5 mm 

 Result:  0.000365  Display:  0.365 mm 

 
The ‚x‘ symbol represents the base of an unit. The format string ‚#\-x\+km‘ 
displays the result in meters or kilometres. 
 
 
 

13.6.1.5 Format Commands 
 
The list below shows the format commands. 
 
$ Result displays hexadecimal 

o  Result displays octal 

b  Result displays binary 

 ^ Displays the result with exponent 
0..9 Number of decimal places 
#.## Number of pounds after decimal point = number of fixed decimal places 

  
Example: 

Format: ‚#\$‘    Display:  8F3. 
Format: ‚$#\$‘   Display:  $8F3. 
Format: ‚#\o‘    Display:  173. 
Format: ‚#\b‘    Display:  10110. 
Format: ‚#\^‘  Display: 1.36 103 
Format: #\^\4  Display:   1.368 103 

 Format: #.##  Display: 1.20 
 

 
 



13.6.2 Font and Background 
 
 

13.6.2.1 Font 
 
The Font menu opens a dialog box to adjust font settings. If the box 
synchronisation is set to Grid sync, the Font menu opens a colour dialog box. 
You can only change the font colour. All other font settings are as on the 
worksheet. 
 
In Object sync or Non sync mode, the Font menu opens a font dialog box. You 
can adjust the font name, size, style and colour. 
 
 
 

13.6.2.2 Background 
 
The menu Background opens a colour dialog box to choose the result box 
background colour. 
 
 
 

13.6.2.3 Transparent 
 
The menu Transparent displays the result box with a transparent background.  
 
 
 

13.6.3 Positions 
 
 

13.6.3.1 Send to Back – Bring to Front 

 

Use Send to Back to change the order of overlapping result or image boxes. 
Click Bring to Front to ensure that a box is visible or to reorder overlapping 
boxes within a worksheet. For example if a result box is included in a technical 
drawing, click the Send to Back menu for the image object to move it below the 
result box. Fix the result box in foreground with a click on the Bring to Front 
menu. 
 



These settings will be saved if th
worksheet from file, RedCrab
boxes, it is important that 
shows the check mark).  
 
 
 

13.6.3.2 Vertical
 

A click on menu Vertical,
function is disabled, when 
  
 
 
 

13.6.3.3 Angle 

 
The menu Angle opens a dialog 
box to adjust the slant of results 
display. It can be an angle in the 
range of + / - 90 degrees, adjustable 
in 0.1 degree increments.
function is disabled, when 
sync is selected.  
 
 
 

13.6.4 Synchronization
 
The properties and positions
worksheet or text and image
 
 
 

13.6.4.1 Grid sync

These settings will be saved if the worksheet store to a file. When you load the 
RedCrab restores the previous settings. For overlapping 

boxes, it is important that Send to Back or Bring to Front is activated (the menu 

Vertical 

Vertical, displays the result box content vertically
function is disabled, when Grid sync is selected.  

 

opens a dialog 
box to adjust the slant of results 
display. It can be an angle in the 

90 degrees, adjustable 
in 0.1 degree increments. This 
function is disabled, when Grid 

Synchronization 

positions of Result boxes can be synchronized
image boxes. 

Grid sync 

When you load the 
restores the previous settings. For overlapping 

is activated (the menu 

displays the result box content vertically. This 

synchronized with the 



 
In Grid sync mode the position
synchronized with the worksheet
with prefix and unit instead 
automatically adapted to the
the result box font size is 
colour can be changed. 
 

RedCrab supports positioning
position. After releasing the
worksheet position, where their
worksheet. 
 
 
 

13.6.4.2 Object sync
 
If the result box mode set to
text or image box. This
engineering drawings. The
position relative to the drawing
 
The popup menu Object
dialog box prompting user 
the parent box which result box
synchronized. Click the left
button on the corresponding
image box and then click
on the dialog box. The position of
result box is now synchronized
parent box. You can move
to any position. Each time you 
parent box, the synchronized
hold their position relative
 
The text of the result box
diagonally, as described above
the popup menu font. 
 
 
 

the position and font settings of the
worksheet. Grid sync is intended for formatted output

instead of the default result display. The 
to the worksheet. If you change the worksheet font size

changed accordingly. In the popup menu

RedCrab supports positioning on the worksheet. You can move the box
releasing the mouse button the box snap into place 

where their text is exactly in line to the

Object sync 

If the result box mode set to Object sync, the box position is synchronized to
This mode is suitable for positioning

The synchronized result boxes always retain
drawing when it is moved on the worksheet

Object sync opens a 
prompting user to determine 

esult box to be 
the left mouse 

button on the corresponding text or 
then click the OK button 

The position of the 
synchronized with the 

move the result box 
Each time you move the 
synchronized result boxes are moved automatically and always 

relative to the parent box. 

box can also be adjusted horizontally, 
above. The font settings can be adjusted

settings of the result box is 
formatted output 
 font settings are 

worksheet font size, 
menu Font, the text 

move the box in any 
the box snap into place on a 

to the text on the 

synchronized to a 
ing results within 

always retain their 
worksheet. 

are moved automatically and always 

horizontally, vertically or 
adjusted as desired by 



13.6.4.3 Non sync 
 
In Non sync mode the result box settings have all the features like Object sync 
mode. But the box is not synchronized with any other objects. 
 
 
 

13.7 Chart Box 
 
Chart boxes are advanced result boxes to display results graphically. The 
handling is similar to the result box. 
 
The popup menu is extended with two menu items: Chart and Options. 
 
 
 

13.7.1 Chart 
 
With the Chart menu you can choose between different chart types. You can 
select the types: Line, Area, Point, Bar and Pie. 
 
 
 

13.7.2 Option 
 
With Options item you can choose the properties of the Chart box. 

 
Axis   scale 
3D   3-D representation 
Marks  write values in the graph 
Legends   Legend of several data series shown 

 X/Y Positions free definition of X and Y coordinates 
 
 
 

13.7.2.1  X/Y Positions 
 

This option allows the free definition of X and Y coordinates. As data source, 

one- and multidimensional arrays are allowed. 



 

In a one-dimensional field, the values are interpreted as X and Y alternate, 

begining with X. 

 

Example: [x, y, x, y, x, y, x, y, x, y] 

 

In multi-line fields, the first row contains the X coordinate and the second row 

the Y-coordinate. 

 

Example: [x, x, x, x, x, x] 

[y, y, y, y, y, y] 

 

This procedure is repeated in the following rows. If the number of rows is odd, 

the last row is ignored. 

 

Before printing the list, the coordinates are sorted, according to the X position. 

This means a line is drawn with ascending X values from left to right. 

  



14.0 Extras Menu 

 
 
 

14.1 Page Lock 
 
With Page Lock on the menu Extras, the editor’s page will be blocked for 
additional entries. This function protects unintentional changes made. For data 
input the cells can be unlocked with Unlock Cell. 
 
 
 

14.2 Cell Unlock 
 
With Unlock Cell on menu Extras cells in a locked page, are unlocked for data 
entry. Select the cells by mouse, and then click Unlock Cell on menu Extras. 
The unlocked fields are marked with an underscore. 
 
To clear the unlocked cells select the cells by mouse, then click Unlock Cell on 
menu Extras. The cells are locked now. 
 
 
 

14.3 Remark 

 
The Remark function marks data in a worksheet as a comment. This function 
can be performed with the function key F2. Comments are ignored by the 
calculator. 
 
To mark the data, first select the range with the mouse, and then click Remark. 
The selected data is displayed in green. You can undo this function using the 
same step. 
 
For longer comments, text boxes are more suitable. Remark is particularly 
suited to parts of a formula or input, temporarily excluded from the calculation 
 
 
 
 

  



15.0 Options Menu
 
 
 

15.1 Column Space
 
The menu Column Space
minimum distance between
minimum value you can 
the value in the bottom, right corner, next to
setting. You can also open the
the number. 
 
 
 
 

15.2 Long Term
 

Switch to LongTerm mode 

multiplication interpreted “abc” as 

interpreted as one word.
colour. The ESC function is disabled
 
 
 

15.3 Display Buffer
 
RedCrab works with a dual screen memory. This 
avoided. However, this feature works only on new generation computers and 
video cards. On older computers, it can lead to slower response to inputs. In this 
case, it is convenient to click 
feature. 
 
 

 

15.4 Keyboard
 

The keyboard input in this description refers to an English keyboard in the 
country's setting English-
some functions are acquired with other key combinations. This concern most of 

Menu 

Column Space 

Space opens a dialog window to set the 
between two formulas in a row. The 

you can set is 2 columns. RedCrab displays 
n the bottom, right corner, next to the keyboard 

open the dialog window with click on 

Long Term 
mode to write long variable names.

multiplication interpreted “abc” as a*b*c. In LongTerm mode, 

as one word. In Long Term mode the ESC Button 
function is disabled. 

Buffer 

RedCrab works with a dual screen memory. This will scroll faster and flicker is 
avoided. However, this feature works only on new generation computers and 
video cards. On older computers, it can lead to slower response to inputs. In this 
case, it is convenient to click Display Buffer on Option menu to eliminate t

4 Keyboard 
The keyboard input in this description refers to an English keyboard in the 

-US When using a non-English keyboard or language, 
some functions are acquired with other key combinations. This concern most of 

g variable names. The implied 

mode, rather "abc" is  

Button is in orange 

faster and flicker is 
avoided. However, this feature works only on new generation computers and 
video cards. On older computers, it can lead to slower response to inputs. In this 

menu to eliminate this 

The keyboard input in this description refers to an English keyboard in the 
English keyboard or language, 

some functions are acquired with other key combinations. This concern most of 



the Ctrl key functions.  If you have problems with the assignment of the keys, 
click Keyboard in the Options menu. It opens with a list of alternative 
keyboards, which differ significantly in important features of the English 
keyboard. Here you select a keyboard that corresponds to your specification. 
Attached you will find images about key codes of the alternative keyboards and 
the occupancy of the Ctrl functions. 
 
 

15.5 Settings to Registry 
 
When you shut down RedCrab, all major settings are stored in the PCs Windows 
Registry. Whenever RedCrab is started, these settings are restored. This 
concerns the keyboard settings, font size, number of decimal places, window 
size and many more. If you start RedCrab from an external source, e.g. USB 
stick from different computers, it does not make sense to save the settings on all 
computers. With the menu Options.Settings to Registry this function can be 
switched. The menu will display the text Settings to File and RedCrab saves the 
settings in the file redcrab.con in the root directory of the program. 
 
 
 

  



16.0 Help Menu 
 
 
 

16.1 About RedCrab 

 
Display the version number and license. 
 
 
 

16.2 Check for Updates 
 
Compare the version of the program with the latest version on the RedCrab 
server. It displays a message if an update is available. To use this function you 
must have an online connection. 



17.0 Work with RedCrab 
 
After program start RedCrab display an empty page, similar to an empty sheet of 
paper. The arithmetic field’s size is 256 x 256 cells.  
 
 
 

17.1 Variable overload 
 
You can assign different values to the same variable. 
 

Example: P = U*I = 

  P = U
2
/R = 

   
But an overloaded variable has no defined value and can’t be used for further 
calculations or result boxes. 
 
 
Overloaded constants can be reused. Example: the constant e is occupied by the 
Euler number e = 2.7182818. You can overload this value and use e for further 
calculations. 
 

Example 1:   x=e=2.7182818 

 

Example 2:  e=11 
  X=2e=22 

 
 
 

17.2 Fractions 
 
Entering a fraction line: Press the keys CTRL+/ (Ctrl + Slash) and a three-
character fraction bar will be displayed. By repeatedly pressing the keys the 
fraction bar is extended by one character forward. In general, it is sufficient if 
you continue entering data above and below the fracture line. When typing the 
numerator or denominator data, the fraction bar is automatically extended by the 
editor as far as it is required. 
 
If you have taken the fraction line, the cursor is in the first column after the line. 
Press in this position Enter key, the cursor moves over the slash to the first 
position of the numerator. After entering the numerator, press again Enter, the 



cursor jump to the first position of the Denominators. After entering the data 
press Enter again. The cursor jump back into the column right of the fraction 
line. 
 

! The fraction bar must exceed at least 1 character front and rear. 

 
Examples: 
 

  123   wrong 
  abc 
  

  123  correct   
   Abc 
 

 

 

17.3 Root 
 
Set the root character with the keys CTRL+1 to the desired position. Then mark 
the area which is to be included under the root. Finally set the cursor on the root 
of character, the editor draws the root symbol over the marked area. 
 
For one-line root calculation, the following steps apply: 
 
1. Set root symbol with CTRL+1. 
2. Enter the data 
3. Holding down the Shift key and with Cursor-left key reposition to the root     
sign. 
 
The editor draws the root symbol over the marked area. 
 
 
For multi-line data in the root (e.g., fractions): 
 
1. Set root symbol with CTRL+1. 
2. Data entry. 
3. Mark the area for the root with the mouse. 
4. Click the mouse on the root symbol. 
 
The editor draws the root symbol over the marked area. 
 
In order to highlight the area, it is sufficient if the last column under the root is 
marked. 



 
To change the area under the root, highlight, as described above, the new field 
and then click the cell of the root sign. The roots then marked the new area. 
 
By double-clicking on the root symbol the root lines around the data is removed. 
 
 
 

17.4  Escape Mode 
 
RedCrab works as described above with implied multiplication. A sequence of 
letters be regarded as a single variable and be multiplied.  
 

Example: c=ab interpreted as c=a*b 

 
If it is necessary for a variable or a function to use a name with more than one 
letter use the Escape mode. The Escape mode is activated by pressing the ESC 
key. All these characters are then interpreted as one word, until the Escape mode 
is switched off. To cancel ESC, press Return or '('. The screen will be printed 
bold characters in Escape mode. 
 
Example:  value = sum – discount 

 
If a bracket follows an Escape variable you must set an operator before the 
bracket. Escape name followed by a bracket without operator is usually 
interpreted as a function call. 
 
For example: correct: sin(12 + a) 

correct: six*(12 + a) 

wrong:  six(12 + a) 

 
 
Different Esc names must be separated by SPACE or operator; otherwise they 
are interpreted as a word 
 
For example:  correct: apple * banana 

correct: apple banana 

wrong : applebanana 

 
 
 



17.5 Fields 
 
The following section describes how to work with dynamic data fields. RedCrab 
can manage multi-dimensional fields. Size and dimensions are limited by the 
resources of the computer only. 
 
The handling of the fields corresponds to the simple variables. That means no 
special declaration of variables is required. To generate a field, a sequence of 
numbers is assigned to a variable. The sequence is written in square brackets and 
separated by commas. 
 

Example: x = [1,3,7,12] 

 
 
The assignment of a series shows the following example. It will be assigned to 
the variable x 180 indices with the values 1 to 180. 
 

Example:  x = [1..180] 

 
 
A series is always expanded in increments of + /- 1. Other step sizes can 
multiply or divide by the field generated. 
 

Example:  x = 5[0..4] = 0  5  10  15  20  

 
  x = [0..5]/5 = 0  0.2  0.4  0.6  0.8  1 

 
  x = 5/[1..5] = 5  2.5  1.67  1.25  1 

 

  x = 2[5..0] = 10  8  6  4  2  0 

 
 
 
Series, individual values and variables can be combined. 
 

Example: x = [1,5..8,12,15] = 1  5  6  7  8  12  15 

 

Example: a = 3          

b = 12 

  x = [1,a..5,b] = 1  3  4  5  12 

 
 



Fields are treated as normal values 
operators and functions. The result is a field
  

Example: [2,4,7] + 10 = 

 
Example:  sin([30,60,90])= 

 

Example: [12,18,36,44] 

 

Example: C = 4.6 10

  f = [1200,1600,2000,2600]

 
 
  XC=                 

 
The example 
four different values of  f.
 
 
Individual components of a field can be accessed via the index.
 

Example:  x = [11..20]
  y = x[1,4,6..8] = 

 
 
 

17.6 Multidimensional
 
To generate multi-line fields,
 

Example: x=[1,2,3;4,5,6]=

     

 
 
If rows have different length, the missing ind
 

Example: x = [1..5;2,4,6;3..9]=
                        

                    

 
Fields with three rows can be written alternative with a large bracket.
 
 

Fields are treated as normal values in calculations and can be combined with all 
and functions. The result is a field as well. 

[2,4,7] + 10 = 12  14  17   (2+10  4+10  7+10)

([30,60,90])= 0.5  0.87  1 

[12,18,36,44] mod 10 = 2  8  6  4 

C = 4.6 10-6 

f = [1200,1600,2000,2600] 

=                 = 28.2  21.2  16,9  13

above shows a list as a result, which contains 
. 

ndividual components of a field can be accessed via the index. 

x = [11..20] 

y = x[1,4,6..8] = 11  14  16  17  18

Multidimensional fields 

fields, separate each row by semicolon. 

x=[1,2,3;4,5,6]= 1  2  3 

  4  5  6 

different length, the missing indexes are filled with zeros.

[1..5;2,4,6;3..9]= 1  2  3  4  5  0  0 

                          2  4  6  0  0  0  0 

                       3  4  5  6  7  8  9

ields with three rows can be written alternative with a large bracket.

in calculations and can be combined with all 

(2+10  4+10  7+10) 

28.2  21.2  16,9  13 

above shows a list as a result, which contains 

 

18 

with zeros. 

1  2  3  4  5  0  0  

2  4  6  0  0  0  0  

3  4  5  6  7  8  9    

ields with three rows can be written alternative with a large bracket. 



 
Example:  
 
 
 
This standard is generally used
following calculations. For multiplication of matrices, 
Mulx function. 
 
By entering the data, as described above, one
generated. Fields with three or more d
computationally. 
 
 
 

17.7 Work with fields
 
Two fields can be operands
the same type. This means
dimensions. An exception is different
of the longer field are ignored.
 

Example: a = [2,3,4,

  b = [10,11,12,

  c = a + b = 

 

Example: a = [2,3,4,5]

  b = [10,11,12,13,14,15

  c = a + b

   
  Excess field length of 
 

Example: a = [2..5; 20..23] 

b = [10..13; 30..33]

  c = a + b = 

     
 

generally used in matrix notation, but has no effect on the 
following calculations. For multiplication of matrices, refer to

By entering the data, as described above, one-and two-dimensional fields are 
generated. Fields with three or more dimensions can be generated 

Work with fields 

operands of a mathematical expression when the fields
This means they must have the same size 

An exception is different length in the first dimension.
are ignored. 

,3,4,5] 

,11,12,13] 

c = a + b =  12 14 16 18  (2+10  3+11  4+12  5+13)

a = [2,3,4,5] 

[10,11,12,13,14,15] 

b =  12 14 16 18   

Excess field length of b (14,15) is ignored. 

a = [2..5; 20..23]  

b = [10..13; 30..33] 

c = a + b =  12 14 16 18   
 50 52 54 56 

in matrix notation, but has no effect on the 
refer to section below 

dimensional fields are 
imensions can be generated 

when the fields are of 
 and number of 

first dimension. The excess 

(2+10  3+11  4+12  5+13) 



Example: a = [2..5; 20..23]                

b = [10..13; 30..33; 40,44,45,48] 

  c = a + b =  12 14 16 18 

50 52 54 56 

   
In this example, the third row of  b is ignored   

 
 

Example: a = [2..5; 20..23]                

b = [10..13; 30..33; 40,44,45,48] 

  c = a + b[1,3] =  12 14 16 18 

      60 65 67 71 

   
  In this example, a from row 1 is added with b from row 3 
 
 
In the examples above, each index of a is added with the corresponding index of  
b. Alternatively RedCrab can calculate fields in which each index of an field a 
is calculated with each index of the field b. The result is a multidimensional 
field of the size indices a times indices b. 
 
The empty brackets following c declares the result as a multidimensional field 
and determines the type of the following calculation. 
 

Example: a = [10,15] 

   b = [2..4] 

   c[] = a+b =  12 13 14  (10+2 10+3 10+4)  

17 18 19  (15+2 15+3 15+4) 

 

Example:   a = [3..6]   
b = [11..15] 

           33 36 39 42 45 

c[] = ab = 44 48 52 56 60 

           55 60 65 70 75 

           66 72 78 84 90 

 
 
The next example shows to multiply a one-dimensional field by a two-
dimensional field. The result is a three-dimensional field. 
 

Example: a = [3..6]   

b = [11..15] 

c[] = ab 
              99 108 117 126 135 



  d[] = ac = 132 144 156 168 180              

             165 180 195 210 225 

           198 216 234 252 270   

 

The display above shows the two-dimensional field of the first level. This is the 
field that lies behind the first row. Other fields can be accessed via index. 
 

Example:        132 144 156 168 180 

d[2] = 176 195 208 224 240 

       220 240 260 280 300 

       264 288 312 336 360 

 

 
The following example shows reading of a single cell from a multi dimensional 
field. b is the value of the cell in the second row and the third column of a. The 
apostrophe is the delimiter. 
 

Example: b = a [2'3] 

 
 
 

17.8 Field Display 
 
The result of a data field is always displayed in result boxes. This avoids display 
problems if not enough space on the worksheet to display large fields. 
 
If you have not assigned a result box to a field variable,  RedCrab automatically 
generates a temporary result box. This temporary box is displayed with a 
transparent background and has a limited pop-up menu. If the result is deleted 
by reset, the result box is deleted too. 
 
One-dimensional data fields are displayed as a horizontal row.  With the pop-up 
menu item Vertical, the display can be switched to a vertical list. 
 
With a click on the pop-up menu item Undocked  you can show the result box in 
a separate window. The function is particularly suitable for large data fields. 
 
 
 



17.9 Constants 
 

e Eulerscher Number: 2.7182818284590452... 

π PI : 3.1415.... 

 

 
 

 

17.10 Error Messages 
 

For error location RedCrab marks the cell in where an error is detected with a 
blue frame. It also marks the incorrect formula with a red frame. 
 

 
 
 
The marking of the entire formula simplifies the localization of errors that cause 
a false positioning. In the example below, an invalid assignment is signaled. The 
red selected box indicates, however, that two formulas were joined because the 
distance is too close. In this example the adjustment of the distance (column 
space) is 4 columns; the distance between the formula is only 2 columns. 
 

 

 



Attachment 
 
 
Key Code  Configuration 
 
 
 

US-English 
 

 
 
 
 

German 
 

 
 
 
 



Italian 
 

 
 
 
 

Brazil (Portuguese) 
 

 
 
 
 
 
 
 
 


